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Executive Summary 

Thales payShield enterprise Hardware Security Module (HSM) is validated by Bloombase InteropLab to run with Bloombase StoreSafe data-at-
rest encryption security solution. This document describes the steps carried out to test interoperability of Thales payShield HSM with Bloombase 
StoreSafe software appliance on VMware ESXi. Client host systems on Microsoft Windows Server, Red Hat Enterprise Linux (RHEL), SUSE Linux 
Enterprise Server (SLES), Oracle Sun Solaris, IBM AIX and HP-UX are tested with Thales payShield powered Bloombase StoreSafe with EMC VNX 
unified storage system as backend storage.
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Purpose and Scope 

This document describes the steps necessary to integrate Thales payShield Hardware Security Module (HSM) with Bloombase 

StoreSafe to secure sensitive enterprise business data-at-rest managed in storage systems. Specifically, we cover the following 

topics: 

● Install and configure Bloombase StoreSafe 

● Integrate Bloombase StoreSafe with Thales payShield 

● Interoperability testing on client host systems including Linux, Windows, IBM AIX, HP-UX and Oracle Sun Solaris 
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Assumptions 

This document describes interoperability testing of Thales payShield with Bloombase StoreSafe. Therefore, it is assumed that 

the reader is familiar with operation of Thales payShield, storage systems and major operating systems including Linux, 

Microsoft Windows, IBM AIX, HP-UX and Oracle Sun Solaris. It is also assumed that the reader possesses basic UNIX 

administration skill-set. The examples provided may require modifications before they could be run in reader’s IT environment. 

As Thales payShield is a third party hardware option to Bloombase StoreSafe data-at-rest encryption security solution, the 

reader is recommended to refer to installation and configuration guides of specific model of Thales payShield for the actual use 

case. We assume the reader has basic knowledge of storage networking and information cryptography. For specific technical 

product information of Bloombase StoreSafe, please refer to our website at http://www.bloombase.com or Bloombase 

SupPortal http://supportal.bloombase.com. 

http://www.bloombase.com/
http://supportal.bloombase.com/
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Infrastructure 

Setup 
The validation testing environment is set up as in below diagram: 
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Thales Hardware Security Module 
 

Hardware Security Module Thales payShield 9000 

Bloombase StoreSafe 
 

Bloombase StoreSafe Bloombase StoreSafe Software Appliance v3.5 on Bloombase OS 5 

payShield Client Software Package PayShield API 1.1.15 

Server VMware Virtual Machine (VM) on VMware ESXi 5.5 

Processor 4 x Virtual CPU (vCPU) 

Memory 8 GB 

Storage System 
 

Storage System EMC VNX Virtual Appliance on ESXi 5.5 

Client Hosts 
 

Model Dell PowerEdge 
R720 

HPE ProLiant 
DL380 Gen8 

IBM System 
x3650 M4 

HPE Integrity 
rx2620 

IBM System p5 
510 

Oracle Sun Fire 
x2100 

Operating 

System 

Microsoft 
Windows 
Server 2012 

Red Hat 
Enterprise 
Linux 6 

SUSE Linux 
Enterprise 11 

HP-UX 11i IBM AIX 7 Oracle Solaris 
11 
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Configuration Overview 

Thales payShield 
Thales payShield is a hardware security module that provides the cryptographic protection needed for payment card 

transactions. It is deployed as an external peripheral for servers running payment-card-related software applications. The key 

management and cryptographic functionalities provided by Thales payShield can also be used by Bloombase StoreSafe for 

encryption protection of data-at-rest for payment and general-purpose use cases. 

Thales payShield can be managed through the Graphical User Interface (GUI) of the local HSM Manager by connecting the 

ethernet management port of the Thales payShield to a computer running the HSM Manager CD with an ethernet cable. Users 

may utilize remote HSM Manager to manage the HSM remotely across a TCP/IP network. 

Thales payShield Configurations 

Once Thales payShield is connected physically with a laptop computer, open the GUI of the local HSM Manager, and select 

“connect” from the File Menu. Then “Login” Thales PsyShield from the File Menu using one or two smartcards to access Operator 

or Security Officer functions. 
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Under the “Edit” Menu, select the appropriate choice to configure the IP address, time and date, secure host communication 

through TLS and IP White List, and logging of Thales payShield. 

Under the “LMKs” Menu, generate a new Local Master Key (LMK) onto smart cards and import it into the HSM, or load an existing 

LMK. 

Under the “Tools” Menu, setup the certificates for secure host communication through TLS. 
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Network Security, Trust and Authentication Configuration 

To enable secure communications through TLS between Bloombase StoreSafe and Thales payShield, their corresponding public 

key certificate signed by the same CA needs to be exchanged between the Bloombase StoreSafe and the Thales payShield 

beforehand. To create the signed certificate at the Thales payShield, a Security Officer will instruct the Thales payShield to 

generate a keypair and a Certificate Signing Request (CSR) containing the public key in PKCS#10 format, and output this to the 

console or HSM Manager screen. The Security Officer will have the public key signed by his/her chosen CA and return the public 

key certificate and CA’s certificate chain to the Thales payShield. The same certificate will also be uploaded to the Bloombase 

StoreSafe’s trust key store. The Security Office will also import the public key certificate of Bloombase StoreSafe and its 

associated CA’s certificate chain to the Thales payShield for authentication purpose. 

Notice that a connection between the Bloombase StoreSafe and the Thales payShield will fail if the Secure Host Communications 

session is attempted to establish using an out-of-date (i.e., expired or not-yet-valid) certificate. 

 

EMC VNX Storage 
EMC VNX virtual appliance is used in this interoperability test which is able to provide storage services over network storage 

protocols including NFS, CIFS, iSCSI, etc. 
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EMC VNX is a unified storage system supporting multiple network storage protocols including NFS, CIFS, HTTP, FCP, FCoE, iSCSI, 

etc. 

 

CIFS and NFS storage resources are provisioned on EMC VNX to be used in this testing. 
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Bloombase StoreSafe 
Bloombase StoreSafe delivers unified data-at-rest encryption security of block storage volumes, files, objects, sequential 

storage devices, etc. In this interoperability test, file-based encryption security service is validated against Bloombase StoreSafe 

with keys managed at Thales payShield HSM.  

 

Bloombase StoreSafe software appliance is deployed as a virtual appliance (VA) on VMware ESXi. 
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Network Security, Trust and Authentication Configuration 

In this interoperability test effort, Bloombase StoreSafe serves as the client of Thales payShield for encryption key access to 

deliver data at-rest encryption services. 

Thales payShield utilizes TLS for data in-flight security protecting privacy of data transmission over network with client 

applications. 

Thales payShield’s security service is trusted by adding the certificate authority of its certificate to Bloombase StoreSafe’s trust 

key store. 
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Thales payShield utilizes certificate-based authentication for client access control. An X.509 compliant key pair is generated and 

entered into Bloombase StoreSafe’s client key store. 

The client certificate is also configured at Thales payShield as a trusted credential which allows access of security services by 

trusted Bloombase StoreSafe instance from over remote network. 

 

 

Thales payShield and Bloombase KeyCastle Integration 

To enable the built-in Bloombase KeyCastle to utilize keys in the network attached Thales payShield HSM, the JAR package of 

the Thales payShield API, its license file, and its dependencies (in JAR format) need to be imported through Bloombase Storesafe 

CLI console, and the hardware security module configuration at Bloombase web management console has to be set up. 

When a Thales payShield is configured at Bloombase web management console, select Module as ‘payshield’ which allows 

embedded Bloombase KeyCastle module to utilize Thales PayShield Command/Response API to access Thales payShield HSM 

via JCE interface. 
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In this scenario, the Thales payShield HSM is assigned a token label namely ‘payShield’. Different settings for connection with 

Thales payShield can be configured by modifying entries in Thales payShield property file 

payment.properties 

deployed at Bloombase StoreSafe instance. 

When Thales payShield HSM resource is properly provisioned at Bloombase StoreSafe, the status would show up as ‘Active’. 

 

Encryption Key Provisioning 

Generate encryption key with name ‘key01’ in bundled Bloombase KeyCastle key life-cycle management tool 
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To generate key in attached Thales payShield HSM, select Key Source Type as “Hardware Security Module”, Module as 

“payshield” and the assigned HSM token label, in this case “payShield”. Ensure you import a key from the HSM before you 

submit the key wrapper. 



Bloombase Interoperability Program   P19 ©  2015 Bloombase, Inc. 
   

 

 

 

Or if key already exists, simply choose from the pull down box. 
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Backend Physical Storage Configuration 

Physical storage namely ‘share01’ is configured to be secured by Bloombase StoreSafe using encryption. 

 

Secure Storage Configuration 

Virtual storage namely ‘share01’ of type ‘File’ is created to virtualize physical storage ‘share01’ for application transparent 

encryption protection over network file protocols including CIFS and NFS. 



Bloombase Interoperability Program   P21 ©  2015 Bloombase, Inc. 
   

 

 

 

Protection type is specified as ‘Privacy’ and secure the backend EMC VNX storage using AES 256-bit encryption and encryption 

key ‘key01’ managed at Thales payShield HSM. 
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CIFS storage protocol relies mainly on user-password authentication for access control. In this test, the Bloombase StoreSafe 

secure storage resource ‘share01’ is provisioned for user ‘user01’ with Microsoft Active Directory integration for user-password 

authentication and single sign-on. 
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Conclusion 

Hardware security module 

● Thales payShield 9000 

passed all Bloombase interopLab's interoperability tests with Bloombase StoreSafe 

 

Bloombase Product Operating System Hardware Security Module 

Bloombase StoreSafe Microsoft Windows Server  Thales payShield 9000 

 Red Hat Enterprise Linux (RHEL)  Thales payShield 9000 

 SUSE Linux Enterprise Server (SLES)  Thales payShield 9000 

 Oracle Solaris  Thales payShield 9000 

 IBM AIX  Thales payShield 9000 

 HP-UX  Thales payShield 9000 
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Disclaimer 

The tests described in this paper were conducted in the Bloombase InteropLab. Bloombase has not tested this configuration 

with all the combinations of hardware and software options available. There may be significant differences in your configuration 

that will change the procedures necessary to accomplish the objectives outlined in this paper. If you find that any of these 

procedures do not work in your environment, please contact us immediately. 
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